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Primers/Probes Design Guideline 
 

TaqMan Probe  Primer  

Probe與 Primer的距離愈近愈好, PCR產物大小建議在 50-150 bp為最佳 

G/C % 為 30-80 % 

避免有重複序列的出現，尤其避免 4個以上 G的出現 

Tm值: 68-70℃ (Quantification assay) 

65-67℃ (Allelic Discrimination assay) 

Tm值: 58-60℃ 

Probe 長度: 
 13~25 bases (TaqMan MGB probe)  

13~30 bases (TaqMan probe) 

Primer 長度:  
20 bases (Optimal) 

避免連續 6個 A的序列出現 

5’端第一個序列不能為 G  

(如果選擇 FAM-dye在 5’端第二個序列也不能為 G) 

選擇C比G多的strand當作probe b

避免 3’端的前 4個序列裡含有 3個或以上 G  

(GGG-MGB-3’ or GGAG-MGB-3’) a

避免probe的中間區域含有 2個或以上的CC di-nucleotides a

3’端的前五個序列裡不能超過 2個 C+G

a: 針對 TaqMan MGB probe 

b: 參數可選擇設定 
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Primers & Probes for Quantification 
 Automatically Design 

進入 Primer Express 3.0軟體 

File→ New→選擇“TaqMan MGB Quantification或 TaqMan Quantification”→ OK 

 
 
 
 
 
 
 
 
 
 
 

Tools →按 “Add DNA File” ，尋找序列存取位置，按下”Add”，將序列檔案加入空白文件。亦

可在”Sequence” Tab中使用 Copy & Paste轉貼或直接輸入序列。         

 

* Primer Express Software只能接受.dan, .txt, .ab1,或.abi的檔案格式, 請事先將欲分析的序列存成純文字檔即

可(若序列是從 database download下來時,請刪除與序列無關之資料) 
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可勾選” Double Strand “, 即會顯示 double stranded DNA sequence 

 

 
Tools上的選項 

1. Exclude:不必要的序列可利用”Exclude Selected Bases” 將序列刪掉 

          - 先選取不要的序列範圍，點選 “Exclude”，即可看見此區域被劃掉 
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2. Junction: 如果已經知道序列上 junction位置則可利用”Junction”  

- 框選 juction的位置(必須含 2 bases)，再點選 “Junction”，即可看見此區域被紅色標

記起來。 

 

 

3. 在”Parameters” Tab中可看到 Primer/Probe Tm值設定及其他 Primers/Probe設計之規範 
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回到 ”Sequence” Tab，Tools → Find Primers/Probes ，軟體即開始找尋適當的 Primers/Probe pairs 

 
Primer Express軟體會找到 Candidate Primers & Probe pairs，一次 search最多能找到 50種組合，這

些組合列於”Primers / Probes” Tab中。中間”Location”說明 primers & probes在序列中的相對位置，

在橫線上方的數字代表起始位置，橫線下方則代表終止位置。 

 

”Sequence” Tab中會顯示出與”Primers / Probes” Tab相對應的一對 Primers/Probe: 粉紅色片段是

Probe的位置，藍色代表 Forward Primer，黃色片段則為 Reverse Primer，如下圖所示。(*但並不表

示此為最佳的設計) 
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在 ”Primers / Probes” Tab中會將每對Primers/Probe的組合列出來，請從中挑選出適當的組合，挑選

方式可依據第 2頁primer/ probe design guideline。在MGB Probe的篩選中，亦可在”Parameters” Tab

中加選”C ”比” G ”多的序列作為進一步篩選的參數。 

 

 
決定 primer/ probe set 之後則可進行存檔，存檔的方式從 File → Save As存檔。如果想將所選擇的

primer/ probe set單獨儲存，可利用 Export → Order Info…的方式，或者要儲存 50個 Primers/Probes

清單，可點選 Export →Primers/Probes List…，以上兩種方式都可存成.txt檔案，在 Excel中開啟。  
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   Manually Design 
當軟體無法自動尋找到 Primer/Probe組合時，先確定 Primer/Probe想要置放的位置 
開啟一個新的 Quantification Document，並把欲設計的序列檔案加入 (參照第 3頁)。 

 

1. Probe的設計: 

在”Sequence” Tab中將 Probe之預定序列 highlight起來 (至少 25 bases之長度，長度依序列結構而

定)後，先利用 Edit中 Copy (Ctrl+C) 之功能複製序列，再依下圖至 Tools→ Primer Probe Test Tool

中，選擇欲設計的 document type (即“TaqMan MGB Quantification或 TaqMan Quantification”)，並確

認 Parameter設定為”Default”，再利用 Paste (Ctrl+V) 將序列貼在 Probe 1 欄位，從右邊即可觀察測

試序列之 Tm, %GC和長度是否合適。 

註: probe第一個序列不能為 G，且序列裡面 C的數目要比 G還要多 

 
 

此時若 Tm超過設定值(68℃to 70℃)，可直接在 Probe 1 欄位中框選不同的序列片段，並觀察右邊

對應的 Tm, %GC和長度，以找出最適當的 Probe (請參照 primer/ probe design guideline)，若框選到

適合的片段，點一下”Trim”，就可以將未框選的序列直接刪除，而留下需要的 Probe序列。 

 



 
 
Primer Express Operation Guide 

 

 9

當 Probe序列確定之後，回到”Sequence” Tab中將 Probe之確定序列 highlight起來並利用 Edit → 

Annotate → ” Probe”  將 probe序列固定起來，此時 probe的位置會被標定成綠色。 

 

之後，可利用 Tools → Find Primers/Probes ，找出與設定之 Probe配對的 Forward / Reverse 

Primers。若自動搜尋無法找到配對的 Primers可依以下步驟進行 Forward / Reverse Primers的設

計。 
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2. Forward Primer設計:  

在”Sequence” Tab中將預定 Primer序列 highlight起來(至少 25 bases之長度，切勿與 Probe序列重

疊)後，先利用 Edit中 Copy (Ctrl+C)之功能複製序列，再依下圖至 Tools → Primer Probe Test Tool

中，利用 Paste (Ctrl+V) 將序列貼在 Fwd Primer 欄位，從右邊即可觀察測試序列之 Tm, %GC和長

度是否合適。 

 
確認 Forward Primer的 Tm值在 58-60℃，如果 Tm值不符合，可直接在 Fwd Primer中框選不同的

序列片段，並觀察右邊對應的 Tm, %GC和長度，以找出最適當的 Primer (請參照 primer/ probe design 

guideline)，若框選到適合的片段，點一下”Trim”，就可以將未框選的序列直接刪除，只留下需要

的序列。 

當 Fwd Primer序列確定之後，回到”Sequence” Tab中將確定序列 highlight起來，再利用 ” Forward 

Primer” 固定起來，此時的 Fwd Primer位置會被標定成藍色。 
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3.  Reverse Primer設計:  

在”Sequence” Tab中將預定的 Reverse序列 highlight起來(至少 25 bases之長度，切勿與 Probe序列

重疊)後，然後利用 Edit →” Copy Complement ”將序列貼到 Tools → Primer Probe Test Tool中的 Rev 

Primer 欄位。 

 
確認 Reverse Primer 的 Tm值也能符合在 58-60℃，如果 Tm值不符合，可直接在 Rev Primer中框

選不同的序列片段，並觀察右邊對應的 Tm, %GC和長度，以找出最適當的 Primer (請參照 primer/ 

probe design guideline)，若框選到適合的片段，點一下”Trim”，就可以將未框選的序列直接刪除，

只留下需要的序列。 

當 Rev Primer序列確定之後，回到”Sequence” Tab中將確定序列 highlight起來，再利用 ” Reverse 

Primer” 固定起來，此時的 Rev Primer位置會被標定成粉色。 
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決定 primer/ probe set後可利用 Copy & Paste功能轉貼到一個新的 text檔，並 save起來做為未來參

考資料。另外，也可以把此次設計 document進行存檔，存檔的方式從 File → Save As存檔。 
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SYBR Green I Primer for Quantification 
 Automatically Design 

進入 Primer Express 3.0軟體 

File→ New→選擇“TaqMan MGB Quantification或 TaqMan Quantification”→ OK 

 

 

 

 

 

 

 

 

 

 

 

Tools →按 “Add DNA File” ，尋找序列存取位置，按下”Add”，將序列檔案加入空白文件。亦

可在”Sequence” Tab中使用 Copy & Paste轉貼或直接輸入序列。 

 
* Primer Express Software只能接受.dan, .txt, .ab1,或.abi的檔案格式, 請事先將欲分析的序列存成純文字檔即可

(若序列是從 database download下來時,請刪除與序列無關之資料) 
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可勾選” Double Strand “, 即會顯示 double stranded DNA sequence 

 

 

Tools上的選項 

1. Exclude:不必要的序列可利用”Exclude Selected Bases” 將序列刪掉 

          - 先選取不要的序列範圍，點選 “Exclude”，即可看見此區域被劃掉 
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2. Junction: 如果已經知道序列上 junction位置則可利用”Junction”  

- 框選 juction的位置(必須含 2 bases)，再點選 “Junction”，即可看見此區域被紅色標

記起來。 

 
 

3. 在”Parameters” Tab中可看到 Primer Tm值設定及其他 Primers設計之規範 
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回到 ”Sequence” Tab，Tools → Find Primers/Probes ，軟體即開始找尋適當的 Primers/Probe pairs 

 
Primer Express軟體會找到 Candidate Primers & Probe pairs，一次 search最多能找到 50種組合，這

些組合列於”Primers / Probes” Tab中，請注意若是進行 SYBR Green primer設計，不需看 probe

序列，只需參考 primer序列組合。中間 ”Location”說明 primers & probes在序列中的相對位置，在

橫線上方的數字代表起始位置，橫線下方則代表終止位置。 

 

”Sequence” Tab中會顯示出與”Primers / Probes” Tab相對應的一對 Primers/Probe: 粉紅色片段是

Probe的位置，藍色代表 Forward Primer，黃色片段則為 Reverse Primer，如下圖所示。(*但並不表

示此為最佳的設計) 
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在 ”Primers / Probes” Tab中會將每對 Primers/Probe的組合列出來，請從中挑選出適當的組合，挑

選方式可依據第 2頁 primer/ probe design guideline。 

 

* SYBR Green primer設計必須要注意避免有 primer dimer的產生 

-在”Primers / Probes” Tab中任選一組 primer set，從右下方來觀察 Primer Secondary Structure，

則可得之 Hairpin, Self Dimers及 Cross Dimers的情況，選擇鍵結數越少越好的組合，其中又以

GC的鍵結比例越少越好。 
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決定 primers set 之後則可進行存檔，存檔的方式從 File → Save As存檔。 

如果想將所選擇的 primers set單獨儲存，可利用 Export → Order Info…的方式，或者要儲存 50個

Primers/Probes清單，可點選 Export →Primers/Probes List…，以上兩種方式都可存成.txt檔案，在

Excel中開啟。 
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  Manually Design 
當軟體無法自動尋找到 Primer組合時，先確定 Primer想要置放的位置 
開啟一個新的 Quantification Document，並把欲設計的序列檔案加入 (參照第 13頁)。 

 

1.  Forward Primer設計:  

在”Sequence” Tab中將預定 Primer序列 highlight起來(至少 25 bases之長度，長度依序列結構而定)

後，先利用 Edit中 Copy (Ctrl+C)之功能複製序列，再依下圖至 Tools → Primer Probe Test Tool中，

選擇欲設計的 document type (即“TaqMan MGB Quantification或 TaqMan Quantification”)，並確認

Parameter設定為”Default”，利用 Paste (Ctrl+V) 將序列貼在 Fwd Primer 欄位，從右邊即可觀察測

試序列之 Tm, %GC和長度是否合適。 

 
 

確認 Forward Primer的 Tm值在 58-60℃，如果 Tm值不符合，可直接在 Fwd Primer中框選不同的

序列片段，並觀察右邊對應的 Tm, %GC和長度，以找出最適當的 Primer (請參照 primer/ probe design 

guideline)，若框選到適合的片段，點一下”Trim”，就可以將未框選的序列直接刪除，只留下需要

的序列。 
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2.  Reverse Primer設計:  

在”Sequence” Tab中將預定的 Reverse序列 highlight起來(至少 25 bases之長度，長度依序列結構而

定)後，然後利用 Edit →” Copy Complement ”將序列貼到 Tools → Primer Probe Test Tool中的 Rev 

Primer 欄位。 

 
 

 

確認 Reverse Primer 的 Tm值也能符合在 58-60℃，如果 Tm值不符合，可直接在 Rev Primer中框

選不同的序列片段，並觀察右邊對應的 Tm, %GC和長度，以找出最適當的 Primer (請參照 primer/ 

probe design guideline)，若框選到適合的片段，點一下”Trim”，就可以將未框選的序列直接刪除，

只留下需要的序列。 
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3. 在 SYBR Green primer設計中必須要注意避免有 primer dimer的產生 

-在 Primer Probe Test Tool中選定 primer set後，點選 ”Show Secondary Stucture”，即可從右下方來

觀察此組 Primers的二級結構，如 Hairpin, Self Dimers及 Cross Dimers的情況，避免鍵結數太多，

其中又以 GC的鍵結比例越少越好，如果此組 primer二級結構嚴重，請重新尋找適當位點。 

 
 

當 Fwd Primer序列確定之後，回到”Sequence” Tab中將確定序列 highlight起來，再利用 ” Forward 

Primer” 固定起來，此時的 Fwd Primer位置會被標定成藍色。 
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當 Rev Primer序列確定之後，回到”Sequence” Tab中將確定序列 highlight起來，再利用 ” Reverse 

Primer” 固定起來，此時的 Rev Primer位置會被標定成粉色。 

 
 

 

決定 primer/ probe set後可利用 Copy & Paste功能轉貼到一個新的 text檔，並 save起來做為未來參

考資料。另外，也可以把此次設計 document進行存檔，存檔的方式從 File → Save As存檔。 
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Primers & Probes for Allelic Discrimination 
 Automatically Design 

進入 Primer Express 3.0軟體 

File→ New→選擇“TaqMan MGB Allelic Discrimination或 TaqMan Allelic Discrimination”→ OK。

建議使用 TaqMan MGB probe設計，以達到更佳效果。 
 

 

Tools →按 “Add DNA File” ，尋找序列存取位置，按下”Add”，將序列檔案加入空白文件。亦

可在”Sequence” Tab中使用 Copy & Paste轉貼或直接輸入序列。 

 
* Primer Express Software只能接受.dan, .txt, .ab1,或.abi的檔案格式, 請事先將欲分析的序列存成純文字檔即可

(若序列是從 database download下來時,請刪除與序列無關之資料) 
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標定 SNP位點 

將 SNP位點 highlight，Edit → Annotate → “SNP Target ” ，選擇此 SNP 位點的變異型(variant)。 

 
例如：在 528位置是 G/A 的 SNP，點選 G和 A之間的”R”，然後按下 OK，SNP位點即被標定成

紅色小寫的 r。 
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Tools → Find Primers/Probes ，軟體即開始找尋適當的 Primers/Probes pairs 

 
Primer Express軟體會找到 Candidate Primers & Probes pairs，一次 search最多能找到 50種組合，這

些組合列於”Primers / Probes” Tab中。中間”Location”說明 primers & probes在序列中的相對位置，

在橫線上方的數字代表起始位置，橫線下方則代表終止位置。 

 

”Sequence” Tab中會顯示出與”Primers / Probes” Tab相對應的一對 Primers/Probes: 粉紅色片段是

Probe 1的位置，綠色片段則代表 Probe 2的位置(2個 Probe重疊的序列會呈現綠色)，藍色代表

Forward Primer，黃色片段則為 Reverse Primer，如下圖所示。(*但並不表示此為最佳的設計) 
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在 ”Primers / Probes” Tab中會將每對Primers/Probe的組合列出來，請從中挑選出適當的組合，挑選

方式可依據第 2頁primer/ probe design guideline。在MGB Probe的篩選中，亦可在”Parameters” Tab

中加選”C ”比” G ”多的序列作為進一步篩選的參數。 

 

 

決定 primer/ probe set 之後則可進行存檔，存檔的方式從 File → Save As存檔。 

如果想將所選擇的 primer/ probe set單獨儲存，可利用 Export → Order Info…的方式，或者要儲存

50個 Primers/Probes清單，可點選 Export →Primers/Probes List…，以上兩種方式都可存成.txt檔案，

在 Excel中開啟。 
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 Manually Design 
當軟體無法自動尋找到 Primer/Probe組合時，先確定 Primer/Probe想要置放的位置 
開啟一個新的 Allelic Discrimination Document，並把欲設計的序列檔案加入(參照第 23頁)。 

 

1.  設計 Probe for Allele 1: 

在”Sequence” Tab中，將 SNP位點 highlight起來，Edit → Annotate → 按 “SNP Target ” ，然

後選擇此 SNP 位點的變異型(請參照第 24頁)。將 Probe1之預定序列 highlight起來(大約 13~25 bases

之長度)後，先利用 Edit中 Copy with Allele 1 (Ctrl+Shift+W) 之功能複製序列，再至 Tools→ Primer 

Probe Test Tool中，選擇欲設計的 document type (即“TaqMan MGB Allelic Discrimination或 TaqMan 

Allelic Discrimination”)，並確認Parameter設定為”Default”，再利用Paste (Ctrl+V) 將序列貼在Probe1

欄位，此時 Allele 1 variant base變成小寫的字體 (此例變成”g”)，從右邊即可觀察測試序列之 Tm, 

%GC和長度是否合適。 

 

註: probe第一個序列不能為 G，且序列裡面 C的數目要比 G還要多 
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此時若 Tm超過設定值(65℃to 67℃)，可直接在 Probe 1 欄位中框選不同的序列片段，並觀察右邊

對應的 Tm, %GC和長度，以找出最適當的 Probe (請參照 primer/ probe design guideline)。若框選到

適合的片段，點一下”Trim”，就可以將未框選的序列直接刪除，而留下需要的 Probe序列。 

 
 

 

SNP位點置放 

請將 SNP位點置於 Probe序列中間三分之一的區域或從中間到 3’端最後 2個 base之前的區域，不

能置放在最後兩個 base，如下圖： 
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2.  設計 Probe for Allele 2: 

在”Sequence” Tab中，將 Probe2之預定序列 highlight起來(大約 13~25 bases之長度)後，先利用 Edit

中 Copy with Allele 2 (Ctrl+Shift+M) 之功能複製序列，再至 Tools→ Primer Probe Test Tool中，利

用 Paste (Ctrl+V) 將序列貼在 Probe2 欄位，此時 Allele 2 variant base變成小寫的字體 (此例變

成”a”)，從右邊即可觀察測試序列之 Tm, %GC和長度是否合適。 

 

 

 

此時若 Tm超過設定值(65℃to 67℃)，可直接在 Probe 1 欄位中框選不同的序列片段，並觀察右邊

對應的 Tm, %GC和長度，以找出最適當的 Probe (請參照 primer/ probe design guideline)。若框選到

適合的片段，點一下”Trim”，就可以將未框選的序列直接刪除，而留下需要的 Probe序列。注意

probe1和 probe2之間的 Tm值差異不能超過 1℃以上。 
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3. Forward Primer設計:  

在”Sequence” Tab中將預定 Primer序列 highlight起來(至少 25 bases之長度，切勿與 Probe序列重

疊)後，先利用 Edit中 Copy (Ctrl+C)之功能複製序列，再依下圖至 Tools → Primer Probe Test Tool

中，利用 Paste (Ctrl+V) 將序列貼在 Fwd Primer 欄位，從右邊即可觀察測試序列之 Tm, %GC和長

度是否合適。 

 

 

確認 Forward Primer的 Tm值在 58-60℃，如果 Tm值不符合，可直接在 Fwd Primer中框選不同的

序列片段，並觀察右邊對應的 Tm, %GC和長度，以找出最適當的 Primer (請參照 primer/ probe design 

guideline)，若框選到適合的片段，點一下”Trim”，就可以將未框選的序列直接刪除，只留下需要

的序列。 
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4. Reverse Primer設計:  

在”Sequence” Tab中將預定的 Reverse序列 highlight起來(至少 25 bases之長度，切勿與 Probe序列

重疊)後，然後利用 Edit →” Copy Complement ”將序列貼到 Tools → Primer Probe Test Tool中的 Rev 

Primer 欄位。 

 
 

確認 Reverse Primer 的 Tm值也能符合在 58-60℃，如果 Tm值不符合，可直接在 Rev Primer中框

選不同的序列片段，並觀察右邊對應的 Tm, %GC和長度，以找出最適當的 Primer (請參照 primer/ 

probe design guideline)，若框選到適合的片段，點一下”Trim”，就可以將未框選的序列直接刪除，

只留下需要的序列。 
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決定 primer/ probe set後可利用 Copy & Paste功能轉貼到一個新的 text檔，並 save起來做為未來參

考資料。另外，也可以把此次設計 document進行存檔，存檔的方式從 File → Save As存檔。 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

技術支援請電洽: 0800251326 
或 e-mail至 TWSupport@appliedbiosystems.com 

http://www.appliedbiosystems.com.tw 
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